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BE1-11 Preface 

Preface 
This instruction manual provides basic installation and setup information for BE1-11 Protection Systems. 
To accomplish this, the following information is provided: 

• BESTCOMSPlus® software installation and operation 
• Power supply connections 
• Settings configuration 
• Programming BESTlogic™Plus programmable logic 

For complete information on a specific BE1-11 Protection System, refer to one of the following instruction 
manuals: 

• BE1-11d, DC Power Protection System, Publication 9424200761 
• BE1-11f, Feeder Protection System, Publication 9424200990 
• BE1-11g, Generator Protection System, Publication 9424200994 
• BE1-11i, Intertie Protection System, Publication 9424200993 
• BE1-11m, Motor Protection System, Publication 9424200996 
• BE1-11t, Transformer Protection System, Publication 9424200995 

Conventions Used in this Manual 

Important safety and procedural information is emphasized and presented in this manual through 
warning, caution, and note boxes. Each type is illustrated and defined as follows. 
 

Warning! 

Warning boxes call attention to conditions or actions that may cause 
personal injury or death. 

 

Caution 
Caution boxes call attention to operating conditions that may lead to 
equipment or property damage. 

 

Note 
Note boxes emphasize important information pertaining to installation 
or operation. 

 
  



ii  9424200772 

Preface  BE1-11 

 
12570 State Route 143 

Highland IL  62249-1074 USA 
www.basler.com 
info@basler.com 

Tel:  +1 618.654.2341 
Fax:  +1 618.654.2351 

 
© 2023 by Basler Electric 

All rights reserved 
First printing:  April 2014 

 
 

Warning! 

READ THIS MANUAL. Read this manual before installing, operating, or maintaining the BE1-11. Note 
all warnings, cautions, and notes in this manual as well as on the product. Keep this manual with the 
product for reference. Only qualified personnel should install, operate, or service this system. Failure to 
follow warning and cautionary labels may result in personal injury or property damage. Exercise 
caution at all times. 

 
 

Basler Electric does not assume any responsibility to compliance or noncompliance with national code, local code, 
or any other applicable code. This manual serves as reference material that must be well understood prior to 
installation, operation, or maintenance. 

For terms of service relating to this product and software, see the Commercial Terms of Products and Services 
document available at www.basler.com/terms.  
This publication contains confidential information of Basler Electric Company, an Illinois corporation. It is loaned for 
confidential use, subject to return on request, and with the mutual understanding that it will not be used in any 
manner detrimental to the interests of Basler Electric Company and used strictly for the purpose intended. 

It is not the intention of this manual to cover all details and variations in equipment, nor does this manual provide 
data for every possible contingency regarding installation or operation. The availability and design of all features 
and options are subject to modification without notice. Over time, improvements and revisions may be made to this 
publication. Before performing any of the following procedures, contact Basler Electric for the latest revision of this 
manual. 
The English-language version of this manual serves as the only approved manual version. 

 

http://www.basler.com/
mailto:info@basler.com
http://www.basler.com/terms
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BE1-11 Revision History 

Revision History 
A historical summary of the changes made to this instruction manual is provided below. Revisions are 
listed in reverse chronological order. 

Visit www.basler.com to download the latest hardware, firmware, and BESTCOMSPlus® revision 
histories. 

Instruction Manual Revision History 

Manual Revision 
and Date Change 

F, Mar-23 • Updated to latest style 
• Removed mention of CD-ROM and updated BESTCOMSPlus Installation 

E, Feb-19 • Added information for BE1-11d 
• Minor edits throughout manual 

D1, Nov-18 • Added Prop 65 warning on back of cover page 
D, May-17 • Minor text edits throughout manual 
C, Jul-16 • Added Windows 10 compatibility for BESTCOMSPlus software 

• Replaced Figures 4 and 6 to keep consistent with BESTCOMSPlus version 
3.14.00 

• Added a note about standard I/O option in the paragraph above Figure 2 
B, Dec-15 • Updated Figure 12 to show Primary A pickup setting 
A, Apr-14 • Initial release 

https://www.basler.com/
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BE1-11 Quick Start Guide 

Quick Start Guide 
This guide provides basic installation and setup information about BE1-11 Protection Systems. Upon 
receipt of the BE1-11, check the model and style number against the requisition and packing list for 
agreement. If there is evidence of shipping damage, file a claim with the carrier, and notify the Basler 
Electric Regional Sales Office, your sales representative, or a sales representative at Basler Electric, 
Highland, Illinois. 

If the BE1-11 is not installed immediately, store it in the original shipping carton in a moisture- and dust-
free environment. 

 

   Note  
Do not connect a USB cable between the PC and the BE1-FLEX until 
BESTCOMSPlus® is installed. Connecting a USB cable before setup 
is complete may result in errors. 

Maintenance 

Preventive maintenance consists of periodic replacement of the backup battery and periodically checking 
that the connections between the BE1-11 and the system are clean and tight. The front cover should be 
removed only when replacing the backup battery for the real-time clock. Ensure that the BE1-11 is 
powered off and taken out of service before removing the front cover. BE1-11 units are manufactured 
using state-of-the-art, surface-mount technology. As such, Basler Electric recommends that no repair 
procedures be attempted by anyone other than Basler Electric personnel. 

Storage 

This device contains long-life aluminum electrolytic capacitors. For devices that are not in service (spares 
in storage), the life of these capacitors can be maximized by energizing the device for 30 minutes once 
per year. 

Install BESTCOMSPlus® Software 

BESTCOMSPlus software is built on the Microsoft® .NET Framework. The setup utility that installs 
BESTCOMSPlus on your PC also installs the BE1-11 plugin and the required version of .NET Framework 
(if not already installed). BESTCOMSPlus operates with systems using Windows® 7 SP1, Windows 8.1, 
and Windows 10 version 1607 (Anniversary Edition) or later. System recommendations for the .NET 
Framework and BESTCOMSPlus are listed in Table 1. 

Table 1. System Recommendations for BESTCOMSPlus and the .NET Framework 

System Type Component Recommendation 
32/64 bit Processor 2.0 GHz 
32/64 bit RAM 1 GB (minimum), 2 GB (recommended) 

32 bit Hard Drive 200 MB (if .NET Framework is already installed on PC) 
4.5 GB (if .NET Framework is not already installed on PC) 

64 bit Hard Drive 200 MB (if .NET Framework is already installed on PC) 
4.5 GB (if .NET Framework is not already installed on PC) 
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To install BESTCOMSPlus, a Windows user must have Administrator rights. 

1. Download BESTCOMSPlus from www.basler.com. 

2. Click the installation button for BESTCOMSPlus. The setup utility installs BESTCOMSPlus, the .NET 
Framework (if not already installed), the USB driver, and the BE1-11 plugin for BESTCOMSPlus on 
your PC. 

When BESTCOMSPlus installation is complete, a Basler Electric folder is added to the Windows 
programs menu. This folder is accessed by clicking the Windows Start button and then accessing the 
Basler Electric folder in the Programs menu. The Basler Electric folder contains an icon that starts 
BESTCOMSPlus when clicked. 

Power Up and Activate the BE1-11 Plug-In 

The BE1-11 plugin is a module that runs inside the BESTCOMSPlus shell. The BE1-11 plugin contains 
specific operational and logic settings for only BE1-11 protection systems. Uploading settings to the BE1-
11 is possible only after activating the BE1-11 plugin. 

Note that if a BE1-11 is not connected, you will not be able to configure certain Ethernet settings. 
Ethernet settings can be changed only when an active USB or Ethernet connection is present. Refer to 
the Communication chapter in the appropriate BE1-11 instruction manual for more information. 

USB Connection 
The USB driver was copied to your PC during BESTCOMSPlus installation and is 
installed automatically after powering the BE1-11. USB driver installation progress is 
shown in the Windows Taskbar area. Windows will notify you when installation is 
complete. 

Connect a USB cable between the PC and your BE1-11. A typical USB cable with a B-
type connector is shown to the right. 

 

   Note  

In some instances, the Found New Hardware Wizard will prompt you 
for the USB driver. If this happens, direct the wizard to the following 
folder: 
C:\Program Files\Basler Electric\USB Device Drivers\ 

 

If the USB driver does not install properly, refer to the Troubleshooting chapter. 

Apply Operating Power 
The nominal power supply values are listed on the front-panel label. See Figure 1 for an example. 

 
Figure 1. Front Panel Label Example for BE1-11f 

Connect rear terminals A6, A7, and A8 (ground) to a power supply. Figure 2 shows the rear terminals of 
the BE1-11f in a J type case with standard I/O option. Figure 3 shows the rear terminals of the BE1-11f in 
an H or P type case. Apply operating power consistent with the nominal power supply values listed on the 
front-panel label. Wait until the boot sequence is complete. 

https://www.basler.com/
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Figure 2. PWR Rear Terminals (J Type Case with Standard I/O Option) 

 

 
Figure 3. PWR Rear Terminals (H or P Type Case) (BE1-11f, BE1-11i, and BE1-11g only) 
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Start BESTCOMSPlus® and Activate BE1-11 Plugin 
To start BESTCOMSPlus, click the Start button, point to Programs, Basler Electric, and then click the 
BESTCOMSPlus icon. During initial startup, the BESTCOMSPlus Select Language screen is displayed 
(Figure 4). You can choose to have this screen displayed each time BESTCOMSPlus is started, or you 
can select a preferred language and this screen will be bypassed in the future. Click OK to continue. This 
screen can be accessed later by selecting Tools and Select Language from the menu bar. 

 
Figure 4. BESTCOMSPlus Select Language Screen 

The BESTCOMSPlus platform window opens. Select New Connection from the Communication pull-down 
menu and select BE1-11. See Figure 5. The BE1-11 plugin is activated automatically after connecting to 
a BE1-11. 

 
Figure 5. Communication Pull-Down Menu 

The BE1-11 Connection screen shown in Figure 6 appears. Select USB Connection and then click the 
Connect button. 

The BE1-11 plugin opens indicating that activation was successful. You can now configure the BE1-11 
communication ports and other BE1-11 settings.   
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Figure 6. BE1-11 Connection Screen 

Programming the BE1-11 
This section contains an introduction to BESTCOMSPlus, explains summary screens, and gives an 
example of settings elements and programming logic for the BE1-11f Feeder Protection System. Other 
applications are similar. 

Introduction to BESTCOMSPlus® 
BESTCOMSPlus is a Windows®-based, PC application that provides a user-friendly, graphical user 
interface (GUI) for use with Basler Electric communicating products. The name BESTCOMSPlus is an 
acronym that stands for Basler Electric Software Tool for Communications, Operations, Maintenance, and 
Settings. 

BESTCOMSPlus provides the user with a point-and-click means to set and monitor the BE1-11. The 
capabilities of BESTCOMSPlus make the configuration of one or several BE1-11 Protection Systems fast 
and efficient. A primary advantage of BESTCOMSPlus is that a settings scheme can be created, saved 
as a file, and then uploaded to the BE1-11 at the user’s convenience. 

The BE1-11 plugin opens inside the BESTCOMSPlus main shell. The same default logic scheme that is 
shipped with the BE1-11 is brought into BESTCOMSPlus by downloading settings and logic from the 
BE1-11 or by selecting application type (D, F, I, G, T, or M) on the Style Number screen. This gives the 
user the option of developing a custom setting file by modifying the default logic scheme or by building a 
unique scheme from scratch. 

BESTlogic™Plus Programmable Logic is used to program BE1-11 logic for protection elements, inputs, 
outputs, alarms, etc. This is accomplished by the drag-and-drop method. The user can drag elements, 
components, inputs, and outputs onto the program grid and make connections between them to create 
the desired logic scheme. 

BESTCOMSPlus also allows for downloading industry-standard COMTRADE files for analysis of stored 
oscillography data. Detailed analysis of the oscillography files can be accomplished using BESTwave 
software. 

Figure 7 illustrates the typical user interface components of the BE1-11 plugin with BESTCOMSPlus. 
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Figure 7. BESTCOMSPlus Typical User Interface Components 

Click the View drop-down button to switch between the Settings Explorer and Metering Explorer or split 
the view between both. The Settings Info Panel displays settings ranges. A workspace can be opened, 
saved, or set as default. See Figure 8. 

 
Figure 8. View Drop-Down Button 

Summary Screens 
Summary screens provide an overview of the system setup. The legend, located in the lower right-hand 
corner, provides interpretation for the various indicated colors. The current state of a protection and 
control function or element is indicated by the color of the adjacent indicator. If the function is enabled, the 
color is green. If the function is disabled only by a setting (such as zero), the color is yellow. If the function 
is disabled only by a mode, the color is blue. If the function is disabled by both a setting and mode, the 
color is gray. The System Summary screen is available by clicking BE1-11 in the Settings Explorer as 
shown in Figure 9. Summary screens are also available for General Settings, Alarm Configuration, 
Protection, and Control.   
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Figure 9. System Summary Screen 

Programming Example 
Changing default logic is sometimes required to match the protection requirements of the system. 
Additionally, elements must be enabled and operating settings set. This example demonstrates how to 
configure typical nominal settings and program the 50-3 instantaneous overcurrent element. System 
nominal quantities are set to 69.3 volts and 3.6 amps. The 50-3 element is set for a 5.62 amp pickup and 
a 30 second time delay. Additionally, the element pickup output is logically wired to output 4 and a user 
alarm. 

Step 1: Start BESTCOMSPlus and select New Connection, BE1-11 from the Communication pull-down 
menu to connect to the BE1-11. See Figure 5. 

Step 2: The BE1-11 Connection screen appears. See Figure 6. Select USB Connection and click 
Connect. 

Step 3: Select Download Settings and Logic from Device from the Communication pull-down menu. This 
copies all settings and logic from the BE1-11 to BESTCOMSPlus. 

Step 4: Click on the View drop-down button and de-select Show Metering Panel and Show Setting 
Information. See Figure 8. This maximizes the settings workspace. 

Step 5: In the Settings Explorer, click the “+” next to BE1-11. This expands the sub menus in the tree. 
Now expand System Parameters and select the Power System screen. See Figure 10. 

Step 6: Under Nominal Settings, enter settings for (secondary) Phase Voltage (69.3 V) and (secondary) 
Phase Current (3.6 A). 

Step 7: In the Settings Explorer, expand Protection, Current and select the Instantaneous Overcurrent 
(50-3) screen. See Figure 11. 

Step 8: Select the Mode (3 Phase) and enter settings for Pickup (5.62 A) and Time Delay (30,000 ms).   
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Figure 10. Power System Screen 

 
Figure 11. Instantaneous Overcurrent (50-3) Screen 

Step 9: In the Settings Explorer, click BESTlogicPlus Programmable Logic to open the logic diagram. 
Click the Logic Page 1 tab. See Figure 12. Examine the 50-3 element. The Logic 0 connected to 
the Block input indicates that the 50-3 element is never blocked. 

Off-Page Inputs/Outputs are used to make connections between logic pages and help keep logic 
diagrams free from clutter. The Trip output is connected to an Off-Page Output named 50-3 Trip. 
This 50-3 Trip Off-Page Output is carried over to Logic Page 2 (Figure 13) where it becomes an 
Off-Page Input. The 50-3 Trip Off-Page Input and several others are OR gated to the Trip Bus 
Off-Page Output which is carried over to Logic Page 3 (Figure 14) where it becomes an Off-
Page Input. The Trip Bus Off-Page Input in connected to physical Output 1 on the BE1-11. 
Therefore, the OUT1 contacts operate when the 50-3 element is tripped. 
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Figure 12. BESTlogicPlus Logic Page 1 

 
Figure 13. BESTlogicPlus Logic Page 2 
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Figure 14. BESTlogicPlus Logic Page 3 

Step 10: In this step, the Pickup output of the 50-3 element is connected to Output 4. When the Pickup 
output of the 50-3 element is true, the label of Output 4 is displayed in the fault report and/or 
sequence of events report. The label is named in Step 12. Click the Logic Page 1 tab and then 
click the I/O tab at the bottom. Expand Output Objects and then Physical Outputs. Click and 
drag OUT4 over to the logic diagram. Click on the Pickup output of the 50-3 element and drag it 
to the input of OUT4 to make a connection. Refer to Figure 15. 

 
Figure 15. BESTlogicPlus Programming OUT4 

Step 11: In this step, the Pickup output of the 50-3 element is connected to User Alarm 1. When the 
Pickup output of the 50-3 element is true, the label of the user alarm is displayed on the Alarms 
screen on the front-panel display and in the fault report and/or sequence of events report. The 
label is named in Step 13. Click the Logic Page 1 tab and then click the Elements tab at the 
bottom. Locate the User Alarm 1 element. Click and drag USERALM1 over to the logic diagram. 
Click on the Pickup output of the 50-3 element and drag to the input of USERALM1 to make a 
connection. Refer to Figure 16. 
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Figure 16. BESTlogicPlus Programming User Alarm 1 

Step 12: Click the Save button to save the logic to BESTCOMSPlus memory for later inclusion in the 
settings file. See Figure 17. 

 
Figure 17. BESTlogicPlus Toolbar 

Step 13: In the Settings Explorer, expand Programmable Outputs, Contact Outputs, and name Output #4 
(50-3 Pickup) as shown in Figure 18. 

Step 14: In the Settings Explorer, expand Alarm Configuration, User Programmable Alarms, and name 
User Programmable Alarm #1 (50-3 Pickup) as shown in Figure 19. 

 
Figure 18. Contact Outputs Screen 
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Figure 19. User Programmable Alarms Screen 

Step 15: Figure 20 shows the user-defined labels of OUT4 and USERALM1 that were named in Step 13 
and Step 14. 

Step 16: Select Save from the File pull-down menu to save your new settings file. 

Step 17: To make your new settings active in the BE1-11, select Upload Settings and Logic to Device 
from the Communication pull-down menu. Enter the username and password. 

 
Figure 20. OUT4 and USERALM1 with User-Defined Labels 



 

  



 


	Cover
	Preface
	Quick Start Guide
	Quick Start Guide
	Maintenance
	Storage
	Install BESTCOMSPlus® Software
	Power Up and Activate the BE1-11 Plug-In
	USB Connection
	Apply Operating Power
	Start BESTCOMSPlus® and Activate BE1-11 Plugin

	Programming the BE1-11
	Introduction to BESTCOMSPlus®
	Summary Screens
	Programming Example






